Epson Stylus® NX210 Series

Quick Guide

Basic Copying, Printing, and Scanning
Maintenance
Solving Problems
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Loading Paper</td>
<td>5</td>
</tr>
<tr>
<td>Using Special Papers</td>
<td>7</td>
</tr>
<tr>
<td>Copying a Document or Photo</td>
<td>9</td>
</tr>
<tr>
<td>Placing the Original on the Glass</td>
<td>9</td>
</tr>
<tr>
<td>Copying a Document</td>
<td>10</td>
</tr>
<tr>
<td>Copying a Photo</td>
<td>11</td>
</tr>
<tr>
<td>Printing From a Memory Card</td>
<td>12</td>
</tr>
<tr>
<td>Compatible Cards and Image Formats</td>
<td>12</td>
</tr>
<tr>
<td>Inserting the Card</td>
<td>13</td>
</tr>
<tr>
<td>Printing Photos From the LCD Screen</td>
<td>14</td>
</tr>
<tr>
<td>Printing Photos From an Index Sheet</td>
<td>15</td>
</tr>
<tr>
<td>Printing From Your Computer</td>
<td>17</td>
</tr>
<tr>
<td>Printing in Windows</td>
<td>17</td>
</tr>
<tr>
<td>Printing With a Macintosh</td>
<td>19</td>
</tr>
<tr>
<td>Selecting the Correct Paper Type</td>
<td>24</td>
</tr>
<tr>
<td>Scanning a Document or Photo</td>
<td>25</td>
</tr>
<tr>
<td>Quick Scanning With the Scan Button</td>
<td>25</td>
</tr>
<tr>
<td>Custom Scanning With Epson Scan Software</td>
<td>26</td>
</tr>
<tr>
<td>Restoring and Correcting Photos</td>
<td>27</td>
</tr>
<tr>
<td>Maintaining Your Printer</td>
<td>28</td>
</tr>
<tr>
<td>Checking the Print Head Nozzles</td>
<td>28</td>
</tr>
<tr>
<td>Cleaning the Print Head</td>
<td>29</td>
</tr>
<tr>
<td>Checking Ink Levels</td>
<td>30</td>
</tr>
<tr>
<td>Checking Ink Levels</td>
<td>30</td>
</tr>
<tr>
<td>Purchasing Epson Ink Cartridges</td>
<td>30</td>
</tr>
<tr>
<td>Replacing Ink Cartridges</td>
<td>31</td>
</tr>
</tbody>
</table>
Solving Problems .................................................. 34
Checking for Software Updates ................................. 34
Error Indicators .................................................... 35
Problems and Solutions ......................................... 36
Where to Get Help ............................................... 38

Notices ............................................................... 39
Introduction

After you have set up your Epson printer as described on the Start Here sheet, turn here to:

■ Make a copy of a document or photo
■ Print photos from a memory card
■ Get the basic steps for printing from your computer
■ Scan a document or photo and restore or correct the color, if necessary
■ Perform routine maintenance and solve simple problems

This book tells you how to do most of these things without ever turning on your computer! For additional instructions, see the on-screen Epson Information Center (which includes your user’s guide) by double-clicking its icon on your desktop.

Please follow these guidelines as you read the instructions:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your printer.

Tip:
Tips contain hints for better copying, scanning, and printing.
Loading Paper

You can print documents and photos on a variety of paper types and sizes. For details, see page 7.

1. Open the paper support and pull up the extensions. Then open the output tray, pull out the extensions, and raise the stopper.

2. Flip the feeder guard forward, then squeeze the edge guide and slide it left.
3. Insert the paper, glossy or printable side up, against the right edge and behind the tab. (Load letterhead or pre-printed paper top edge first.)

You can load up to 120 sheets of letter-size plain paper, 80 sheets of matte, or 20 sheets of photo paper. Load other papers one sheet at a time. See your on-screen Epson Information Center for more information.

**Note:**
The type of paper you choose affects the way your printout looks. If you are just making a copy or printing a rough draft, plain paper is fine. However, for the best results, you’ll want to use one of Epson’s special ink jet papers designed for your printer. For example, your photos will look great printed on Epson Ultra Premium Photo Paper Glossy (see page 7 for more information).

4. Slide the edge guide against the paper, but not too tightly.

**Note:**
For instructions on loading envelopes, see your on-screen Epson Information Center.
Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central® at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Epson Ultra Premium Photo Paper</strong></td>
<td><strong>Glossy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Borderless 4 × 6 inches</td>
<td>S041934</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Borderless 8 × 10 inches</td>
<td>S041946</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041935</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S042182</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S042174</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper</strong></td>
<td><strong>Glossy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Borderless 4 × 6 inches</td>
<td>S041808</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S042183</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S041667</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper</strong></td>
<td><strong>Semi-gloss</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td><strong>Epson Photo Paper Glossy</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Borderless 4 × 6 inches</td>
<td>S041809</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S041649</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S041271</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Epson Bright White Paper</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td><strong>Epson Premium Presentation</strong></td>
<td><strong>Paper Matte</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S042180</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td><strong>Epson Premium Presentation</strong></td>
<td><strong>Paper Matte Double-sided</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Copy a Document or Photo

Follow the instructions in this section to position your originals correctly on the scanner glass and make color or black-and-white copies.

Placing the Original on the Glass

1. Open the document cover and place your original face-down on the scanner glass, with the top facing into the front right corner.

2. Close the cover gently so you don’t move the original.
Copying a Document

You can copy documents onto letter- or A4-size plain paper or Epson special paper just like you would on a copy machine.

1. Press the On button to turn on your Epson printer.
2. Load letter- or A4-size plain paper or Epson special paper in the sheet feeder (see page 5).
3. Place your original document on the scanner glass (see page 9).
4. Press the Copy button to enter copy mode.
5. To print more than 1 copy, press + or – to select the number (up to 99).
6. Press ▲ or ▼ to select Color or B&W copies.
7. To adjust the copy size, press the Copy button and select a percentage using + or –. Or you can press ▲ or ▼ to select Auto (to automatically size the image to fit your paper). When you’re finished, press the Copy button again.
8. Press the paper size button, if necessary, to select Letter Size Plain Paper.
9. Press Start to begin copying.

Tip:
To make a quick draft copy on plain paper, hold down Start until the On light starts flashing.

To cancel copying, press Stop/Clear Settings.
Copying a Photo

You can copy photos onto 4 × 6-inch Epson photo paper (various types available) for instant photo reprints. You can also convert color photos to black-and-white.

1. Press the ☀ On button to turn on your Epson printer.
2. Load 4 × 6-inch Epson photo paper in the sheet feeder (see page 5).
3. Place your original photo on the scanner glass (see page 9).
4. Press the Ⓡ Ⓢ Copy button to enter copy mode.
5. To print more than 1 copy, press + or – to select the number (up to 99).
6. Press ◀ or ▶ to select Color or B&W copies.
7. To adjust the copy size, press the Copy button and select a percentage using + or –. Or you can press ◀ or ▶ to select Auto (to automatically size the image to fit your paper). When you’re finished, press the Copy button again.
8. Press the □ paper size button, if necessary, to select 4” × 6” Photo Paper.
9. Press ◇ Start to begin copying.
   To cancel copying, press ◇ Stop/Clear Settings.
Printing From a Memory Card

Your Epson printer lets you print photos directly from your digital camera’s memory card; just insert it into the memory card slot and you’re ready to print.

See the on-screen Epson Information Center for instructions on copying memory card files between your Epson printer and a computer, and printing photos pre-selected in your camera (DPOF™ or Digital Print Order Format).

Compatible Cards and Image Formats

You can use the following types of cards with your Epson printer:

- SD™
- SDHC™
- miniSD™*
- miniSDHC* 
- microSD*
- microSDHC*
- MultiMediaCard™
- MMCplus™
- MMCmobile™*
- MMCmicro™*
- Memory Stick™
- Memory Stick Duo™*
- Memory Stick PRO™
- Memory Stick PRO Duo™*
- Memory Stick PRO-HG Duo™*
- Memory Stick Micro*
- MagicGate™ Memory Stick
- MagicGate Memory Stick Duo™*
- xD-Picture Card™
- xD-Picture Card Type H
- xD-Picture Card Type M
- xD-Picture Card Type M+

Your Epson printer supports image files that meet the following requirements:

<table>
<thead>
<tr>
<th>Media format</th>
<th>DCF version 1.0 or 2.0 compliant**</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>JPEG</td>
</tr>
<tr>
<td></td>
<td>Supports Exif version 2.21</td>
</tr>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 9200 × 9200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 999</td>
</tr>
</tbody>
</table>

* Adapter required
** DCF is the “Design rule for Camera File system” standard
Inserting the Card

1. Make sure your Epson printer is turned on.
2. Insert your card as shown.

   **Note:**
   Do not force the card into the slot; it won’t go in all the way.

The memory card access light flashes, then stays lit. Now you can:

- View your photos on the LCD display screen and print them (see page 14)
- Print an index sheet so you can select which photos to print (see page 15)

When you want to remove the card, make sure the memory card access light is not flashing, then pull the card straight out of its slot. If your printer is connected to your computer, first prepare the card for removal:

- If the computer is running Windows, click the or icon on the taskbar and select **Safely remove USB Mass Storage Device.** Once you see a confirmation message, remove the card.
- If your printer is connected to a Macintosh, drag the removable disk icon from your desktop into the trash, then remove the card.

**Caution:**
Do not remove the card or turn off your printer while the memory card access light is flashing; you may lose data on the card.
Printing Photos From the LCD Screen

You can select individual photos for printing as you view them on the LCD display screen.

1. Load several sheets of 4 × 6-inch Epson photo paper (various types available; see page 7).

2. Press the Print photos button. You see this screen:

3. Press ◀ or ▶ to move through your photos and display one that you want to print.

4. Press the + or – button to select the number of copies you want of that photo.

5. Repeat steps 3 and 4 to select more photos, if you want.

6. Press the paper size button, if necessary, to select 4”× 6” Photo Paper.

7. When you’re ready to print, press ◇ Start.

To cancel printing, press ◇ Stop/Clear Settings.
Printing Photos From an Index Sheet

You can print an index sheet containing small versions of all the photos on your memory card. Then you can select the photos you want by marking them on the sheet and scanning the sheet. Your Epson printer automatically prints them.

**Printing an Index Sheet**

1. Load several sheets of plain letter- or A4-size paper (see page 5).
2. Insert a memory card (see page 13).
3. Press the Index Sheet button.
4. Make sure option 1 is selected (for printing the index sheet), then press Start.

   The most recent photos are printed on the first index sheet, up to 30 photos per page. If you need to cancel printing, press Stop/Clear Settings.

Now you can select the photos you want to print (see the next section).

**Printing Photos From the Index Sheet**

Once you have printed an index sheet, you can mark the photos you want to print right on the sheet, scan the sheet, and print the photos automatically.

1. Use a dark pen or pencil to fill in the circles on the sheet.

   **Note:**
   Do not use a permanent marker or felt-tip pen; these could damage the scanner glass.

   - Select the paper type and size you want to use.
   - Select a Borderless or With Border layout.
   - If you want to print the date the photo was taken on each photo, fill in the Print date on photos circle.
   - Fill in one circle beneath each photo you want to print. The numbers indicate how many copies you want of that photo. To print one copy of all the photos on the index sheet, fill in the All circle at the top.

Incorrect: ☐ ☐ ☐ ☐
Correct: ☐ ☐ ☐ ☐ ☑
2. Open the document cover. Then place the index sheet face-down on the glass, in the lower right corner so that the top of the sheet is aligned against the right edge of the glass. Close the document cover.

3. Load the type of photo paper on which you want to print your photos.

   **Note:**

4. Make sure your memory card is still inserted and the LCD screen shows option 2 selected (for scanning the index sheet).

5. Press \( \text{Start} \) to start scanning and printing. Wait until printing finishes before printing from any additional index sheets.

   If you need to cancel printing, press \( \text{Stop/Clear Settings} \).
Printing From Your Computer

This section describes the basic steps for printing a photo or document stored on your Windows® or Macintosh® computer. For detailed instructions on printing, see the on-screen Epson Information Center.

Before you start, make sure you've installed your printer software and connected your Epson printer to your computer as described on the Start Here sheet.

**Tip:**
It’s a good idea to check for updates to your Epson printer’s software (see page 34 for instructions).

### Printing in Windows

1. Open a photo or document in a Windows program.
2. Open the File menu and select **Print**. You see a window like this one:

   ![Print window](image)

   - **Select your Epson printer**
   - **Click here to open your printer software**

3. Make sure your Epson printer is selected, then click the **Preferences** or **Properties** button.

   (If you see a **Setup**, **Printer**, or **Options** button, click it. Then click **Preferences** or **Properties** on the next screen.)
4. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 24 for details).

Note: For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab.

5. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

6. For more printing options, click the Advanced tab.

   Note: For more information about print settings, click Help or see your on-screen Epson Information Center.

7. Click OK to save your settings.
8. Click OK or Print to start printing. This window appears and shows the progress of your print job.

Printing With a Macintosh

See the section below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select your Epson printer as the Printer setting.
4. Click the arrow to expand the Print window, if necessary.
5. Select the basic copy and page settings. For borderless printing, choose a Paper Size setting with a Sheet Feeder - Borderless option.

**Note:**
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window.
6. Choose **Print Settings** from the pop-up menu, and select the following print settings:

![Print Settings Menu]

- Choose **Print Settings**
- Select your **Media Type** (see page 24)
- Select **Color** or **Black/Grayscale**
- Select higher quality or faster printing (if available)

7. Choose any other printing options you may need from the pop-up menu. See the on-screen *Epson Information Center* for details.

8. Click the **Advanced** button to change additional settings.

   **Note:**
   For more information on advanced settings click ?.

9. Click **Print**.
10. To monitor your print job, click the printer icon in the dock.

Mac OS X 10.3 to 10.4

1. Open a photo or document in an application.
2. Open the File menu and select Page Setup. Select the following settings:
   - Select your Epson printer
   - Select your Paper Size
   - Select your document or image orientation
   - For borderless printing, choose a Paper Size setting with a Sheet Feeder - Borderless option.
3. Click OK to close the Page Setup window.
4. Select Print from the File menu. Select your Epson printer, choose Print Settings from the pop-up menu, and select the following settings as necessary:

Note:
In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

5. Choose any other printing options you may need from the pop-up menu. See your on-screen Epson Information Center for details.

6. Click the Advanced button to change additional settings.

Note:
For more information on advanced settings click ?.

7. Click Print.
8. To monitor your print job, click the printer icon in the dock.

**Selecting the Correct Paper Type**

Select the correct Type (see page 18) or Media Type (see page 23) setting in your printer software. This tells your Epson printer what kind of paper you’re using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
Scanning a Document or Photo

You can use your Epson Stylus NX210 Series to scan a photo or document and save it on your computer. The Scan button lets you scan quickly using preselected settings, or you can use the Epson Scan software to access more advanced features. For example, you can use Epson Scan to restore faded colors in old photos (see page 27).

Note:
For detailed scanning instructions, see the on-screen Epson Information Center.

Quick Scanning With the Scan Button

Use the Scan button to quickly scan a photo or document and save it on your computer. You can even scan a photo and have it automatically included in an email message.

1. Open the document cover and place your original face-down on the glass, in the front right corner, as shown on page 9.
2. Close the cover gently so you don’t move the original.
3. Press the Scan button.
4. Press ◀ or ▶ to select one of the following options:
   - Scan to PC automatically creates a JPG image and saves it to your computer; ideal for scanning photos
   - Scan to PDF automatically creates a PDF file and saves it to your computer; ideal for scanning documents
   - Scan to Email automatically scans a photo, resizes it, launches your email application, and attaches a JPG image to a new outgoing message
5. Press ◇ Start to begin scanning.

Once your image is scanned, you see its icon in Windows Explorer or Macintosh Finder, or as an attachment in your email application, depending on the option you selected.
Custom Scanning With Epson Scan Software

You can scan original documents and photos and save them as files on your computer using the Epson Scan software. You can also launch Epson Scan from any TWAIN-compliant application, such as Adobe® Photoshop®.

1. Open the document cover and place your original face-down on the glass, in the front right corner, as shown on page 9.

2. Close the cover gently so you don’t move the original.

3. Do one of the following to start Epson Scan:
   - **Windows:**
     Double-click the EPSON Scan icon on your desktop.
   - **Macintosh:**
     Double-click EPSON Scan in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose Import or Acquire, and select your Epson printer.

   You see the Epson Scan window:

4. Select Full Auto Mode as the Mode setting in the upper right corner. (If you are in Home, Office, or Professional Mode, you see a different Epson Scan window.)

5. If you want to restore faded color in a photo or make other corrections, click Customize. Then follow the instructions on page 27.

6. Click the Scan button. The image is scanned and you see its icon in Windows Explorer or Macintosh Finder.
Restoring and Correcting Photos

You can automatically transform a faded, dusty, or badly exposed color photo into one with true-to-life color and sharpness as you scan. Use the Color Restoration and Dust Removal options in Epson Scan’s Full Auto Mode. In Home and Professional Mode, you can also select Backlight Correction to remove shadows from images with too much background light.

**Full Auto Mode**
Click the Customize button, click Dust Removal and/or Color Restoration, click OK, and click Scan.

 Automatically orients your photos based on detected faces and other features. If your photo is not oriented correctly, turn off Auto Photo Orientation and try again.

**Note:**
For more information, see the on-screen Epson Information Center. You can also click Help on the Epson Scan screen for information about all the available settings.
Maintaining Your Printer

Follow the instructions in this chapter for checking and cleaning the print head nozzles and replacing ink cartridges. To align the print head, if necessary, see your on-screen Epson Information Center.

Caution:
To keep your printer looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Load letter- or A4-size paper in the sheet feeder (see page 5).
2. Press the Index Sheet and Scan buttons at the same time.
3. Press ▼ or ► to select Nozzle Check, then press © Start.
4. Check the nozzle check pattern that prints to see if there are gaps in the lines.

   ![Nozzle Check Patterns](image)

   Nozzles are clean

   Nozzles need cleaning

5. If there are no gaps, press © Stop/Clear Settings to finish.
   If there are gaps or the pattern is faint, press © Start to clean the print head (see page 29).
Cleaning the Print Head

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first (see page 31).

1. Load letter- or A4-size paper in the sheet feeder (see page 5).
2. Press the Index Sheet and Scan buttons at the same time.
3. Press ◀ or ▶ to select Head Cleaning, then press ◂ Start.
   - Cleaning takes approximately one minute. When it's finished, you see a message on the display screen.
   - **Caution:**
     - Never turn off the printer during head cleaning or you may damage it.
4. Run a nozzle check (as described on page 28) to verify that the print head is clean.
5. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

**Note:**
If you don’t see any improvement after cleaning the print head four times, turn off the printer and wait at least six hours to let any dried ink soften. Then try cleaning the print head again. If quality does not improve, one of the ink cartridges may need to be replaced. If that doesn’t help, contact Epson as described on page 38.

If you do not use your Epson printer often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking Ink Levels

If an ink cartridge is expended, you see a message on your printer's LCD display screen:

**Note:**
You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing or copying.

You can check ink cartridge levels using your printer software:

- **Windows:** Double-click the printer icon in the bottom right corner of your screen (the taskbar).
- **Macintosh:** Open the Applications folder on your hard drive, then open the EPSON Printer Utility3. Select your Epson printer and click OK, then select EPSON StatusMonitor.

A window may also appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates from Epson.

**Note:**
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen Epson Information Center.

Purchasing Epson Ink Cartridges

You can purchase genuine Epson ink and paper from Epson Supplies Central at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Moderate Use</th>
<th>Standard-capacity</th>
<th>High-capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>88</td>
<td>69</td>
<td>68</td>
</tr>
<tr>
<td>Cyan</td>
<td>88</td>
<td>69</td>
<td>—</td>
</tr>
<tr>
<td>Magenta</td>
<td>88</td>
<td>69</td>
<td>—</td>
</tr>
<tr>
<td>Yellow</td>
<td>88</td>
<td>69</td>
<td>—</td>
</tr>
</tbody>
</table>
Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Note:
Leave the expended cartridge installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

1. Turn on your Epson printer.

2. If an ink cartridge is expended, you see a message on the LCD display screen. Note which cartridges need to be replaced and press ☞ Start.

   If a cartridge is expended, you must replace it to be able to print. If a cartridge is low, you can continue printing until a cartridge needs replacement.

   If you’re replacing a cartridge before you see a message on the LCD display screen, press the Index Sheet and Scan buttons at the same time, select Ink Cartridge Replacement, and press ☞ Start.
3. Open the scanner, and open the cartridge cover.

4. Squeeze the tab on the cartridge and lift it up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

   **Warning:**
   If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

5. Before you open the new cartridge package, shake it gently four or five times. Then remove the cartridge from the package.

   **Caution:**
   Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.

6. Remove the yellow tape from the bottom of the ink cartridge.

   **Caution:**
   Do not remove any other labels or seals, or ink may leak.
7. Insert the new ink cartridge into the holder and push it down until it clicks into place.

8. Once you replace all the cartridges that need replacing, close the cartridge cover and push it down until it clicks into place.

9. Close the scanner.

10. Press OK to begin charging the ink. This takes about 2 minutes. When you see a completion message on the display screen, ink charging is finished.

   **Caution:**
   Never turn off your Epson printer while ink is charging or you’ll waste ink. If you see an ink replacement message on the display screen, press Start and press down all the cartridges securely. Then press Start again.

   **Note:**
   If you replaced a cartridge while copying a document or photo, cancel printing and make sure your original is still placed correctly on the document table. Then copy your original again.

   If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
Solving Problems

If you have a problem with your Epson printer, check the messages on the display screen to diagnose the cause.

You can also check “Problems and Solutions” on page 36 for basic troubleshooting suggestions, or double-click the Epson Information Center icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your NX210 Series software. Open your on-screen Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca/support (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click Start or , select Programs or All Programs, select EPSON, select EPSON NX210 Series, and click Driver Update.
Error Indicators

If you see one of the error codes below, follow the steps here to proceed.

**Note:**
When an error code appears, it will be located in the upper-right corner of the LCD display screen.

<table>
<thead>
<tr>
<th>Error code</th>
<th>Problem and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-01</td>
<td>Paper is out or multiple pages have fed. Load or reload paper in the sheet feeder, then press the Start button to continue.</td>
</tr>
<tr>
<td>W-05</td>
<td>Paper is jammed. Carefully remove the paper jam (see page 36).</td>
</tr>
<tr>
<td>W-02</td>
<td>Paper is jammed. Carefully remove the paper jam (see page 36).</td>
</tr>
<tr>
<td>W-03</td>
<td>One or more ink cartridges is expended. Replace the expended ink cartridge (see page 31).</td>
</tr>
<tr>
<td>W-10</td>
<td>One or more ink cartridges is expended. Replace the expended ink cartridge (see page 31).</td>
</tr>
<tr>
<td>W-11</td>
<td>If you just replaced a cartridge and the error code still appears, the cartridge is not installed correctly. Press the Start button to move the cartridges to the replacement position. Press down on all the installed cartridges, then press the Start button to continue.</td>
</tr>
<tr>
<td>W-13</td>
<td>If you just replaced a cartridge and the error code still appears, the cartridge is not installed correctly. Press the Start button to move the cartridges to the replacement position. Press down on all the installed cartridges, then press the Start button to continue.</td>
</tr>
<tr>
<td>W-41</td>
<td>If you just replaced a cartridge and the error code still appears, the cartridge is not installed correctly. Press the Start button to move the cartridges to the replacement position. Press down on all the installed cartridges, then press the Start button to continue.</td>
</tr>
<tr>
<td>I-11</td>
<td>No memory card is inserted. Insert a memory card (see page 13).</td>
</tr>
<tr>
<td>I-10</td>
<td>The memory card is not installed correctly or there is a problem with the card. Remove it and check the card. Make sure the card is compatible with your Epson printer (see page 12).</td>
</tr>
<tr>
<td>W-30</td>
<td>The index sheet has not been placed on the scanner glass or is not positioned correctly. Check the marks on the sheet, position it correctly, and try printing again (see page 15).</td>
</tr>
<tr>
<td>W-21</td>
<td>The index sheet has not been placed on the scanner glass or is not positioned correctly. Check the marks on the sheet, position it correctly, and try printing again (see page 15).</td>
</tr>
<tr>
<td>W-22</td>
<td>No photos are selected on the index sheet, the paper type is not selected on the index sheet, or the corresponding ovals are not marked correctly on the index sheet. Check the marks on the sheet, position it correctly, and try printing again (see page 15).</td>
</tr>
<tr>
<td>W-23</td>
<td>No photos are selected on the index sheet, the paper type is not selected on the index sheet, or the corresponding ovals are not marked correctly on the index sheet. Check the marks on the sheet, position it correctly, and try printing again (see page 15).</td>
</tr>
<tr>
<td>W-01</td>
<td>Parts inside your Epson printer are at the end of their service life. Contact Epson for help (see page 38).</td>
</tr>
<tr>
<td>E-10</td>
<td>Parts inside your Epson printer are at the end of their service life. Contact Epson for help (see page 38).</td>
</tr>
</tbody>
</table>
Solving Problems

Problems and Solutions
Check the solutions below if you're having trouble using your Epson printer.

Printing and Copying Problems

■ Make sure your original is positioned in the front right corner of the glass. If the edges are cropped, move your original away from the edges slightly.

■ Make sure your paper is loaded short edge first and is positioned against the right side with the edge guide against its left side. Don't load paper above the arrow mark inside the edge guide.

■ Make sure the paper size settings are correct for the paper you loaded.

Paper Feeding Problems

■ If paper doesn’t feed, remove it from the sheet feeder. Flip through the stack to separate the sheets a little. Then reload the paper against the right side, and slide the left edge guide against the paper (but not too tightly).

■ Do not load too many sheets at once. You can load up to 120 sheets of letter-size plain paper, 80 sheets of matte, or 20 sheets of photo paper. Load other papers one sheet at a time. See your on-screen Epson Information Center for more information.

■ Do not load paper with holes punched in it.

<table>
<thead>
<tr>
<th>Error code</th>
<th>Problem and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-02</td>
<td>There is a problem with your Epson printer. Turn it off, wait a few moments, and turn it back on again. If the error is not resolved, contact Epson for help (see page 38).</td>
</tr>
<tr>
<td>E-01</td>
<td>Turn your Epson printer off, make sure no paper is jammed inside (see page 36), and turn it back on. If the error is not resolved, contact Epson for help (see page 38).</td>
</tr>
</tbody>
</table>
■ If paper is jammed, follow these steps:
  1. Gently pull out jammed paper from the output tray or sheet feeder.
  2. If paper is stuck inside, turn off your Epson printer.
  3. Open the scanner, remove the jammed paper and torn pieces, close the scanner, and turn the printer back on.

Print Quality Problems

If you have any problems with the copy or print quality, try these solutions:
■ Make sure the document is placed flat against the document table glass and your Epson printer is not tilted or placed on an uneven surface.
■ Load the paper printable side up (usually the whiter, brighter, or glossy side).
■ Make sure your paper isn’t damp or curled.
■ Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.
■ Make sure the type of paper you loaded matches the paper size and paper type settings on the control panel or in your printer software (see page 24).
■ For the best print quality, use Epson special paper (see page 7) and genuine Epson ink cartridges (see page 30).
■ If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head (see page 29). This unclogs the nozzles so they can deliver ink properly. Run a nozzle check as described on page 28 to see if the print head needs cleaning.
■ Clean the print head as described on page 29.
■ If you notice jagged vertical lines, you may need to align the print head. See your on-screen Epson Information Center for instructions.
■ The ink cartridges may be low on ink. Check your cartridge status (see page 30) and replace cartridges, if necessary (see page 31).
■ If a dotted line appears in the image, clean the document table glass with a soft, dry, lint-free cloth (paper towels are not recommended and may permanently scratch the surface), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.
Where to Get Help

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Epson Stylus NX210 Series)
■ Product serial number (located on the label in back)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration
■ Description of the problem

Then call:

■ U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Notices

Important Safety Instructions

Before using your Epson printer, read and follow these safety instructions:

- Be sure to follow all warnings and instructions marked on your Epson printer.
- Use only the type of power source indicated on the printer label.
- Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
- Place the printer near a wall outlet where the plug can be easily unplugged.
- If you won’t be using the printer for a long period, unplug the power cord from the electrical outlet.
- Always turn off the printer using the \( \text{On} \) button, and wait until the \( \text{On} \) light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
- Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
- Do not let the power cord become damaged or frayed.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
- Do not place the printer near a radiator or heating vent or in direct sunlight.
- Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
- Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.
- Do not open the scanner section while the NX210 Series is copying, printing, or scanning.
- Do not spill liquid on the printer.
Except as specifically explained in your documentation, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not shake ink cartridges after opening their packages; this can cause leakage.
- Do not put your hand inside the printer or touch any cartridges during printing.
- Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the printer from printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

**LCD Display Screen Safety**

- Use only a dry, soft cloth to clean the LCD display screen. Do not use liquid or chemical cleansers.
- If the LCD display screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C351E
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction...
with non-Epson products, or service other than by an Epson Authorized Servicer. If a 
claimed defect cannot be identified or reproduced, you will be held responsible for the 
costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS 
STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY 
OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS 
AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY 
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON 
OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF 
THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and 
some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitations and exclusions may not apply to you. This warranty 
gives you specific legal rights and you may have other rights which vary from jurisdiction 
to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: 

To find the Epson Customer Care Center nearest you, visit 
http://www.epson.com/support.

You can also write to: 
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Epson Stylus are registered trademarks, Epson Exceed Your Vision is a registered logomark, and Supplies Central is a service mark of Seiko Epson Corporation.

Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2009 Epson America, Inc. 1/09